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Movavi PDF Editor
Quick Start Guide

Movavi PDF Editor is a powerful and user-friendly tool for convenient PDF document management.

Step 1: Open a document
Drag and drop a file from Finder onto the Movavi PDF Editor window, or click Open File to open a document.

Dirag mnd drop yoer Sles here

More on opening files

Step 2: Edit document
Click the Pages button at the top of the window to see the editing options.

Blank Page

Append File

Copy
[
Rotate

Delete

Extract

Convert to 1PG,
PMG, BMP

More on editing documents

Step 3: Save the file
1. Click the Save button at the top of the window.
2. In the dialog box, click the Overwrite button.



--------

mme— World society theory

= Argues that domestic political debates and policy reforms are decisively
influenced by a supranational cultural and discursive order that carries with
it normative principles of appropriate political goals and structures,

= International cultural connections are particularly strong in Europe, which
stands out as “the most densely integrated region” of the globe.

= Palicies tend to spread maore rapidly when they conform to general
supranational values,
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More on saving files

Removing trial restrictions
How to activate Movavi PDF Editor

When you first install a copy of Movavi PDF Editor, it will be running in trial mode. To be able to use the program to its fullest after the trial period
expires, you will need to activate it using an activation key that you can purchase from our official website or any of our partners.

Follow the instructions below to activate your copy of Movavi PDF Editor:

Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.

Buy Activation Key

2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase form. IMPORTANT! Be
sure to enter a valid e-mail address: it will be used to deliver your activation key.

3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from support@movavi.com containing
your activation key.

Step 2: Open the activation window
1. Open Movavi PDF Editor.
2. Open the Help menu and choose Activate Software. The activation window will appear.

Or click the key button In the top right-hand corner of the window.

Please enter your activation key:

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Step 3: Enter your activation key

1. Enter the activation key into the corresponding box.

2. Click Activate to complete the activation.

This step requires a working Internet connection to verify your key. If you aren’t connected to the Internet, try offline activation.

Please enter your activation key:
|DDDDDD—11111—22222—33333—44444—55555—66666 |

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Having problems with activation?

I activation is not working as expected, try the following:

- Make sure that the activation key is entered correctly and is intended for the program you are activating.
- Try activating offline via e-mail.

» Contact us at support@movavi.com and we'll help you solve the problem!



https://www.movavi.com/pdf-editor-mac/buynow.html?asrc=pdfe_help
https://www.movavi.com/pdf-editor-mac/buynow.html?asrc=pdfe_help
mailto:support@movavi.com

Activating without Internet access
If the computer you have installed Movavi PDF Editor on is not connected to the Internet, you can activate the program via e-mail.
Getting an activation key

You can purchase an activation key from the official Movavi website or from any of our partners. To purchase a digital copy from the official
website, follow the steps below:

Step 1: Go to the purchase page
To open the purchase page for Movavi PDF Editor:
« In the Help menu, choose Buy Activation Key

» Click the cart button Il in the top right-hand corner of the window, or...
* Follow the link below...

Buy Activation Key

Step 2: Choose a license type

- If you plan to use Movavi PDF Editor at home, click Buy Now on the purchase page to proceed with buying the personal license.

- If you plan to use Movavi PDF Editor at work, in a government institution, or gain profit in any way, go to the Business license tab on the
purchase page.

After that, you will be redirected to an online store depending on your region and the available payment methods. All of our vendor partners are
secure and completely safe.

Step 3: Fill in your billing details

1. Choose any of the available payment methods.

2. Fill in the information required on the page.

3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.

Step 4: Get your activation key

After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the program.
Activation instructions

Activating without Internet access

If you haven't received your activation key within the hour:
» Check the Spam folder of your mailbox,
« Contact support.

Activating PDF Editor
How to activate Movavi PDF Editor
Activating Movavi PDF Editor will let you use the program to its fullest forever. Activation requires an Internet connection to verify your key.

You will need:
- Movavi PDF Editor activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
* Internet access to verify your key. Don't have Internet access? See this guide on offline activation

Step 1: Open the activation window
1. Launch Movavi PDF Editor.
2. Open the Help menu and select Activate Software. The activation window will open.

Or click the key button In the top right-hand corner of the window.

Please enter your activation key:

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Step 2: Enter your activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.

2. Click Activate to verify your activation key.

This step requires a working Internet connection to verify your key. If you aren’t connected to the Internet, try offline activation.

Please enter your activation key:
|DDDDDD—11111—22222—33333—44444—55555—66666 |

Don't have an activation key? Buy now Paste
[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘
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If you have entered the key correctly, you should see a message confirming successful activation. Click OK to complete the activation process and
restart the program.

Having problems with activation?

» Check that the activation key is entered correctly and is intended for the program you are activating.
» Try offline activation,

+ Contact our support team.

Activating without Internet

How to activate Movavi PDF Editor without Internet access
Activation requires Internet access to verify your activation key. If you don't have a working Internet connection on the computer that Movavi PDF
Editor is installed on, you can activate the program via e-mail using any other computer or device. You will be asked to send us an automatically
generated e-mail and then enter the reply into the program’s Activation window.

You will need:
- Movavi PDF Editor activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
+ A device or another computer that can be used to send and receive e-mail.

Step 1: Open the activation window
1. Launch Movavi PDF Editor.
2. Open the Movavi PDF Editor menu and select Activate Software The activation window will open.

Or click the key button In the top right-hand corner of the window.

Please enter your activation key:

Don't have an activation key? Buy now Paste

[] Activate offline (by e-mail)

Need help activating? ‘ Cancel ‘

Step 2: Enter the activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Select the Activate offline option.

3. Click Activate to proceed to the next step.

Please enter your activation key:
000000-11111-22222-33333-44444-55555-00666

Don't have an activation key? Buy now Paste
Activate offline (by e-mail)

Need help activating? ‘ Cancel

Step 3: Send an e-mail with the provided information
The next window contains important activation information that you will need to send us via e-mail in order to activate your program.

Please copy this text and e-mail it to us at reg@movavi.com.
To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444-55555-66666
Hardware ID: CO7HZ1FBDID1
MacProduct ID: applepdfeditorl

E-mail: reg@movavi.com

Copy

After your reguest has been processed, you will receive your registration
key via e-mail. Copy the registration key and paste it into the appropriate
box below.

Enter your registration key:

Paste

MNeed help activating? Back ‘

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer or device that you
will be sending the e-mail from.

2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information you've copled earlier into
the message body and send this e-mail to reg@movavi.com. The activation server will then verify your activation key and send you an automatic
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response containing a registration key, which you will need to enter into the Activation window. You should receive the server's reply within an
hour.

Activating Movavi PDF Editor

Registration Robot (regi@movavi.com)
Activating Movavi POF Editor

Please copy this text and e-mail it to us at reg@movavi.com.
To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444-55555-66666
Hardware ID: 1057-5AEF-38F3-4514-0574-0000-0000-2701

Product ID: applepdieditor
E-mail: reg@movavi.com

EN: :om=o s W | -

Step 4: Enter your registration key

1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.

3. Click Activate to submit the information.

Please copy this text and e-mail it to us at reg@movavi.com.
To ensure a fast response, do not change the body of the message.

Activation Key: 000000-11111-22222-33333-44444-55555-66666
Hardware ID: CO7HZ1FBDID1
MacProduct ID: applepdfeditorl

E-mail: reg@movavi.com

Copy

After your reguest has been processed, you will receive your registration
key via e-mail. Copy the registration key and paste it into the appropriate
box below.

Enter your registration key:

SAHHT-CQYECA2T-WHEJSCFB-1JRSIJSB-QPTOTOLV-MIBSAHHT Paste

MNeed help activating? Back ‘

Once activation Is complete, you may be asked to restart the application.

If you're having problems with offline activation:

- Make sure that the keys are entered correctly and are intended for your version of Movavi PDF Editor.
» Make sure you have administrator rights on your computer.

+ Contact our support team.

Opening files
How to open documents in Movavi PDF Editor
Drag-and-drop
Find the necessary document in Finder and then drag it from Finder right onto the Movavi PDF Editor window.

Dirag and drop yoer Sles here
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Browse
On the start screen, click the Open File button. A Finder dialog box will appear. There, choose the file you want to choose and click Open.
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Recent files
On the start screen, you can see the thumbnails of recently opened files. Click on a thumbnail to open file.

Drag ard drop your fles hers
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Student's book.pdf Book_pdl Docurment ] .pdf

You can also find the list of recently opened files in the File menu. Hover your mouse pointer over Recent Files and select the file you want to
open from the pop-up Mmenu.

& Movavi PDF Editor 1

Recent Files Book.pdf
- Contract.pdf

Presentation.pdf

File menu
Open the File menu and choose Open. A Finder dialog box will appear. There, choose the file you want and click Open.

Zoom and navigation

Go to Pages view

— |
Chapter

“Well, Prince, 50 Genoa and Lucca are now just family estates
of the Buonapartes, But | warn you, if you don't tell me that
this means war, if you still try to defend the infamies and hor-
rors perpetrated by that Antichrist—I really believe he is Anti-
christ—I will have nothing mere to do with yeu and you are no
longer my friend, no longer my 'faithful slave,” as you call vour-
salf! But how do you do? [ see | have frightened you—sit down
and tell me all the news."

It was in July, 1805, and the speaker was the well-known
Anna Pavlovna Scherer, mald of honor and favorite of the Em-
press Marya Fedorovna, With these words she greeted Prince
Wasili Kuragin, a man of high rank and importance, who was
the first to arrive avlovna had had a

cough for some di Page navigation |y suffering from la Zoom controls
grippe; grippe being-tmerrw t. Petersburg, used —
only by t.hB alite.

F<<[ 4 Vo » ™ | — s + [ 100% ||

Zoom



When you open a document, it will be shown in it's actual size. Use the zoom and navigation tools at the bottom of the window to set a

comfortable view. To magnify an image, use the zoom slider at the bottom of the window. You can also zoom in and out using the mouse wheel
while holding down Ctrl.

Navigation
Use the page navigation controls at the bottom of the page or the mouse wheel to flip through pages.

& Gotofirst page

¢ Previous page
> Next page
» (Gotolastpage
Editing documents

Thumbnails mode
To switch to page managing mode, click the Pages button on the top panel.

Results

. * Political (left party cabinet peortfolios), domestic-cultural
[secular/rational values), socic-economic (Human Development Index)
— and global-cultural (world society ties) factors are related to the
S legalization of SSUs.

T * World society ties is the most influential predicter, followed by human

development index, index of secular/rational values and left party

a cabinet portfolios.

* Therefore, the domestic value orientation and the cultural diffusion
approaches fit best with the data.

T 1 | » 5% - e——f— | 1%

Blank Page

Append File

Copy
Paste
Rotate
Delete

Extract

Convert to JPG,
PNG, BMP

Blank page. Inserts a blank page in a selected position.
Append file. Adds all the pages from a selected file at the end of the document.
Copy. Coples selected pages.

Paste. Pastes copied pages next to a selected page.

Rotate Rotates selected pages 90° clockwise.

Delete. Deletes selected pages.

Extract. Saves selected pages as a new PDF document.



Save as image. Saves selected pages as images.

You can also find the editing options in the Pages menu:

& Movavi PDF Editor 1

Rotate Left
Rotate Right
Rotate 180°

Extract
Save as Image

Learn more: Organizing pages | Rotating pages | Deleting pages | Extracting pages | Saving pages as images
Organizing pages
Step 1. Select the page you want to move by simply clicking on it. To select multiple pages, click on them while holding down Ctrl on your
keyboard. To select multiple pages that are next to each other, click on the first and the last page while holding down Shift.

=t gt e e s iy
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Joining files
Step 1: On the right-hand panel, click the Append File button.



Step 2: An Finder window will open. Choose the file you want to append and click the Open button.
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Step 3: All the pages from the selected file will be added at the end of the document. Now you can move them as you wish or delete pages you
don't need.

Learn more:
Organizing pages
Deleting pages

Copying and pasting pages
Step 1: Select the page you want to copy. To select multiple pages, click on them while holding down Ctrl on your keyboard. To select multiple
pages that are next to each other, click on the first and the last page while holding down Shift.

Step 2. Choose Copy on the right-hand panel. You can also right-click on the page and select Copy from the context menu.

10



Step 3. Go to the document you want to paste the copied page in. Select the page after which you want to paste the copied page. Then choose
Paste on the right-hand panel.
You can also right-click on the page and select Paste from the context menu.

To paste the page at the end of the document, right-click anywhere on the program window and select Paste at the end from the context menu.

=y

— RIGHT-CLICK

Paste at the end

Rotating pages
Sometimes pages In scanned document have wrong orientation. With Movavi PDF Editor you can easily fix them.

In viewing mode: right-click on the page you want to rotate in preview panel. To select multiple pages, click on them while holding down Ctrl on

your keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift. Then select
one of the Rotate options from the context menu.

11



Copy

Delete

Rotate Left
Rotate Right
Rotate 180°
Extract

Save as Image

In managing mode: select the page you want to rotate in preview panel. To select multiple pages, click on them while holding down Ctrl on your
keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift. Then on the right-
nand panel, choose Rotate.

You can also right-click the page and select one of the Rotate options from the context menu.

Deleting pages
There are several ways to delete a page in Movavi PDF Editor.

In viewing mode: right-click on the page you want to delete in preview panel. To select multiple pages, click on them while holding down Ctrl on
your keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift. Then select
Delete from the context menu or press Delete on your keyboard.

dictors and statistical controls

Copy
Paste

Pelete lex of the log number of national memberships ta (a) international

wernmental organizations (IG0s), (b) non-governmental
iR i zations (INGOs) and (c) the number of ratified human rights
Rotate Right afies

Rotate 180° lex of secular-rational values

Extract man Development Index
Save as Image

T = —— | 0T

In managing mode: select the page you want to delete in preview panel. To select multiple pages, click on them while holding down Ctrl on your
keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift. On the right-hand
panel, choose Delete.

You can also right-click the page and select Delete from the context menu or press Delete on your keyboard.

12
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Editing objects

Click the Edit Objects button on the top right corner of the window.

* Select the object.
* SImply drag the object to move it.
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- To rotate or delete the object, right-click on it and choose one of the options from the pop-up menu.
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Merging documents
Step 1. Select Merge Files on the start page.

Dvag and drop your fles hene
ar

]
i
1
:
1

s
M Fil
’ﬂ erge Files

Step 2. The merging window will open. Click Select Files to add files from an Finder window or simply drag and drop them onto the window.

fdd POF or image files by dicking the button belaw or drag and drop them here.

| o Select Files '

Step 3. Rearrange files by simply dragging them to the desired position.

14



To delete a document from the list, click on the cross button next to It.

Step 4. Click Merge. The new merged file will be opened in a new tab and you will be able to continue editing.

See also: Joining files

Extracting pages
Step 1. In Pages mode, select the page you want to delete in preview panel. To select multiple pages, click on them while holding down Ctrl on
your keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift.

i e el i it ol s ]
B T s 2 o 1 prmmmm—mes o
e e nn [ . — a2 L i
) - Gl ——— ERe—"
S Fr—
Lt ST
7 8 9 10 i It
E ARl L el kT fad
uuuuu
pheie bl —— ——— e imege | 7 == ErTRI
e = : e NA—
e - ki T ity

Step 2: On the right-hand panel, choose Extract. You can also right-click on the page and select Extract from the context menu.

15
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Step 3: An Finder window will open. Choose where you want to save your file and the file name. Then click the Save button. The selected pages
will be saved as a new document.

oy POF Edir

Save As: |F'resentatinn_new | w I

Tags:

Where: [0 Movavi PDF Editor

D S P B P
R — e e i oty

i

Saving pages as images
Step 1. In Pages view mode, right-click on the page you want to save as image. To select multiple pages, click on them while holding down Ctrl
on your keyboard. To select multiple pages that are next to each other, click on the first page and the last one while holding down Shift.
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Step 2: On the right-hand panel, choose Save as Image. You can also right-click on the page and select Save as Image from the context menu.

160
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Convert to JPG,
PNG, BMP
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Step 3: An Finder window will open. Choose where you want to save your file and the file name. Then click the Save button. The selected pages
will be saves as separate images.

oy POF Edir
Save As: | Slides > I
o . Tags:
Where: [ Movavi PDF Editor

6 ;ﬁ ‘ | PMNG (*.png) BI

Saving files
How to save an image in Movavi PDF Editor
To overwrite the existing file:
Click the Save button In the top left-hand corner or open the File menu and click Save. In the dialog box, click the Overwrite button.

World society theory

= Argues that domestic paolitical debates and policy reforms are decisively
10 influenced by a supranational cultural and discursive order that carries with
it normative principles of appropriate political goals and structures,

= International cultural connections are particularly strong in Europe, which
stands out as “the most densely integrated region” of the globe.

= Policies tend to spread maore rapidly when they conform to general
supranational values,

€e | o |71 2 O [) = e—fp— %

To save document as a new file:

Step 1: Open the Movavi PDF Editor menu and click Save As.

Step 2. In the Save File dialog box, choose where you want to save your file and the file name.
Step 3: Finally, click Save.

17
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Where: [ Movavi PDF Editor
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* International cultural connections are particularly strongin Europe, which
- stands out as "the most densely integrated region” of the globe.

* Policies tend to spread more rapidly when they conform to general
supranational values.
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See also:
Extracting pages
Saving pages as images
Help and Support

If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team.

Write to us at suppport@maovavi.com
or click the button on the right to ask a support specialist via live chat.

Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our support team
specialists may ask you for additional information that Is required to solve your problem: these may include your license key, log files, and files you
were working with, but never personal information. We value your privacy!

Have you checked the FAQ section?
Your question may have already been answered!

System Requirements
The minimum system requirements represent the lowest hardware specifications that are guaranteed to run Movavi PDF Editor. If your computer
meets the recommended configuration, then is sure to run smoothly on your computer.

Minimum system requirements Recommended configuration
Movavi PDF Editor
Operating system Mac OS X® 10.7 or higher
Processor 64-bit Intel® processor
Display resolution 1024x768, 32-bit color
RAM 1GB 4 GB or more
Avallable disk space 330 MB 1 GBor more
Additional requirements Administrator permissions are required for installation

Internet connection

18


mailto:support@movavi.com
https://www.movavi.com/support/

	Movavi PDF Editor
	Table of Contents
	Quick start guide
	Removing trial restrictions
	Getting an activation key
	Activating PDF Editor
	Activating without Internet

	Opening files
	Zoom and navigation
	Editing documents
	Organizing pages
	Joining files
	Copying and pasting pages
	Rotating pages
	Deleting pages
	Editing objects

	Merging documents
	Extracting pages
	Saving pages as images
	Saving files
	Help and Support
	System Requirements


